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President’s Corner by N.C. Sizemore
Hello Everyone,
I hope that by the time 
you read this, you (and I) 
are enjoying beautiful 
Florida Springlike weather! 
If you missed our January 

meeting, you missed a wonderful opportunity 
to hear how a local community effort is paving 
the way to ultimately reduce health care costs 
and improve your healthcare provider’s ability to 
care for you. They do this by linking all of them 
to all of your healthcare information which will 
reduce duplicate testing and imaging and pre-
vent contra-indicated prescriptions. That’s the 
short version. The long version was more inter-
esting and informative. My interest in this subject 
dates back to July 28, 2008 when Dr. Melvin 
Seek presented this concept to the Kiwanis 
Club of Ocala. I tried, unsuccessfully, to get Dr. 
Seek to present this to our club a few times and 
never succeeded. Our Program Director, Burt 
Stephens did me one better. He got the data-
base developer (who probably knows more 
about its mechanics than Dr. Seek does, to 
make the presentation last month.  Better yet, 
the developer Bob Holloran, is a MAC user and 
said he is going to join our group! 
	 Speaking of Kiwanis and programs: I am the 
program chair for The Kiwanis Club of Ocala 
for the month of February. I have found that 
it is easier to get four programs for Kiwanis for 
a month than it is to get one one program for 
OMUG. Why? because OMUG programs have 
to be related to MACS— Kiwanis programs 
can be related to anything interesting. This is  
another reason why I appreciate Burt so much 
and urge everyone to help him with program 
suggestions and /or presentations. Another 
thing I am working on for Kiwanis is our an-
nual spring Gala (dinner dance auction) which 
is a major event to raise funds to support the  
numerous projects our club does to promote 
literacy, safety, and character for the children of 
Marion county. FMI: http://ocalakiwanis.org/in-
dex.php?type=news&cat=20 (I’m also Kiwanis 
webmaster).

If you missed the January Workshop, you also 
missed a detailed talk about iCal – I learned a 
lot – I even learned some MAC basics I was 
unaware of. (I’m ashamed to tell you what!) OK 
I’ll tell you. A two finger click on the MacBook 
Pro is a right click. I didn’t know that. Phil does 
a great job with these workshops and he had 
the attendees help him rank interest in future 
workshops. You will see the results of this in the 
March issue of MUGSHOT.
	 In Apple news, Steve Jobs is on medical 
leave again. We wish him well. In the meantime, 
the company seems to be in good hands with 
an experienced team including COO Tim Cook 
running the show. Apple had fantastic results 
for the quarter just ended. They sold over 16 
million iPhones, over 7 million iPads, and over 
4 million Mac computers. The article I read 
did not mention iPods but they obviously sold  
untold millions of those as well.  
	 I’m looking forward to our February meet-
ing where our own BOB ADAMS will present a 
program contrasting the iPad with the MacBook 
Pro. One of the things I learned in the January 
workshop is if Shelley and I are attending these 
workshops together, we need another portable 
computer. Should it be an iPad which I would 
like to have, or another MacBook? My heart says 
iPad but I think my brain says laptop as I don’t 
think the “OSes” (at this time) are sufficiently 
compatible to make a workshop on one suit-
able for the other. I’ll wait to see what Bob has 
to say before making a final decision.
	 In closing, you may have been happy to hear 
a rumor that Apple was putting “Genius Bars” in 
Best Buy stores. The latest on that rumor is: “it 
is not true”. Not true for the reason that Genius 
Bars would under cut Geek Squad sales and  
reduce sales of extended warranties. This could 
be just Apple and Best Buy’s attempt to quell 
the rumor mill until they are ready to announce; 
my guess is it will be a long time, if ever, before 
we see a “Genius Bar” in our local Best Buy.
NCS m
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Apple Mail housekeeping tips— 
The Apple Mail application is an excellent email 
client that supports many email types and is easy 
to configure and use. However, unless you do 
some periodic housecleaning your mailboxes will 

get cluttered and the application will slow down.
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	 1.	The first, and most obvious thing, is to slim down your mailboxes a bit. 
	 Create a new folder in Mail and move all your old emails into that folder (or use the Archive  
	 function if you have a Gmail account). This way mail only has to load the most recent emails 	
	 when it launches and instead of having to synchronize a list of over 20,000 emails with 	
	 the server it only has to deal with 500 or so, saving your precious bandwidth if you are on a 	
	 mobile connection. You will always be able to find your archived mail by using Mail’s excellent 	
	 search tool.

	 2.	It is a good idea to rebuild your mailbox every now and then. Like everything else 	
	 on your computer it may become corrupted which can slow down or crash Mail, so select 	
	 Rebuild from the Mailbox menu to have Mail check and automatically repair it.

	 3.	Clean your previous recipients list. Mail stores a list of everyone you’ve ever sent a 	
	 message to so that it can suggest their email addresses when you are writing a new email. 	
	 The problem is that many of these recipients are people you only emailed once, or addresses 	
	 which have changed so the list can become full of out of date and irrelevant addresses.  
	 Select “Previous Recipients” from the Window menu to clean up the list. 

	 4.	Finally, if you are using Mail to read RSS feeds it might be a good idea to go through 	
	 your subscriptions and delete the ones you no longer read as Mail essentially treats an RSS 	
	 subscription as a mailbox. This means that as the number of posts increases Mail will slow 	
	 down, so keep an eye on your feeds!

Add the OMUG meeting calendar to iCal on your computer—
	 The OMUG meeting and workshop schedule is maintained as a google calendar which can 	
	 be easily added to your computer’s iCal application. This can help you keep track of any 	
	 schedule changes and any events that might be of interest to OMUG members. As with most 	
	 things on our Macs there are several ways to do this, but the easiest is to subscribe using the 	
	 public icalshare website. Here is how .....

	 1.	Go to the icalshare website; http://www.icalshare.com/
	 2.	Search for ocala; then  select ”ocala mac user group”

	 3.	Click “subscribe to calendar”
	 4.	A window will pop up with the URL to the OMUG calendar; do not change 
	 anything. Just click “subscribe”

	 5.	Another window will open and you can change the name of the calendar, add an 
	 optional description, change options for alarms, attachments, to do items, and set an 
	 auto-refresh time. I suggest keeping all the default settings except the refresh time.  
	 Use the drop-down menu to select “every day.”

	 6.	Click OK.

And lastly—
	 A peaceful break.  
	 Don’t worry, no surprises at the end.

	 http://www.donothingfor2minutes.com/

De-authorizing Your Mac 
When You Get Rid of It

When you are getting rid of your 
old Mac and getting a new one, 
you probably know that you need 
to wipe out the hard drive and 
reinstall a fresh copy of Mac OS X, 
but there is one other step called 
“de-authorizing” that many people 
don’t think about. 
	 Authorizing your Mac lets you 
play protected media such as TV 
Shows, Movies and Music purchased 
before 2008. (Apps from the App/ 
Mac App Store don’t need to be 
authorized.) You can authorize up 
to 5 Macs with one Apple ID. 
	 Since few people have 5 Macs, 
most people never bump into 
the limit. The problem comes in, 
however, when you get rid of a 
computer without de-authorizing it. 
	 If you had two Macs, sold one 
without de-authorizing, and bought 
a new one, you are now using three 
of your authorizations. Certain 
major repairs can require you to 
re-authorize the Mac when fixed so 
if you didn’t de-authorize before the 
repair, there goes another one of 
your authorizations. 
	 De-authorizing your Mac is 
easy. Go to iTunes and go to Store 
/ Deauthorize This Computer… on 
the Menu Bar. 
	 You can check how many of your 
5 authorizations have been used by 
going to your account information 
screen in the iTunes Store. (Click 
your Apple ID at the top right of the 
iTunes Store window.) 
	 If you have used all 5 of your au-
thorizations, there is a De-authorize 
All button. Click this button and 
then you will need to re-authorize 
each of your current Macs. You 
can only De-authorize All once per 
year..  m

Thanks to: ChrisB of Basics4Mac

http://www.icalshare.com/
http://www.donothingfor2minutes.com/
http://www.donothingfor2minutes.com/
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Beyond Sunset: The Different  
Phases of Twilight— edited from an article by 
James Brandon, of the Digital Photography School

Photographer James Brandon 
explores the magical world of 
twilight that begins after the sun 
has disappeared beneath the 
horizon.

© Jacob Lucas

Click here for the complete article!

Editor’s note— this article has been presented  
for those of you that want to push the envelope  
of your digital photo capture beyond the  
ordinary.

Sunsets are one of the most common and widely photographed events in nature. They are stun-
ning and inspiring to watch and never seem to last quite long enough before everything is over. 
Once the sun dips below the horizon, the majority of people pack up their gear and head home. 
They see a setting sun as the end of shooting, but they are missing so much! 
	 What most photographers don’t understand is that once the sun has disappeared, a new 
window of opportunity begins, the three different phases of twilight, each with very distinct and 
unique features that open up different worlds of opportunities for your images.

Sunrise and Sunset— The period of time leading up to sunset or directly after sunset is 
the most popular times for photographers. The light is beautiful and perfect for portraits and 
landscapes. The sunlight is diffused and less harsh, and beautiful warm tones are cast across 
the horizon. Sunsets and sunrises are also popular photographic opportunities because the sun 
acts as another interesting element in a photograph because of it’s low relative position to the 
horizon, which can’t be done during the day time in most cases. These times of day are spiritual, 
calming and invigorating. They have a way of making people stop and take everything in. Twilight 
is upon them and the many photo ops of the evening have just begun.

Civil Twilight— Civil twilight is the brightest phase of twilight and occurs from the moment the 
sun dips below the horizon and lasts until the center of the sun is 6 degrees below the horizon. 
This period of time lasts about 30 minutes on average but can be longer or shorter depending 
on the time of year and your position on the globe. During civil twilight, you may also be able 
to see the brightest stars in the sky, as well as some planets like Venus. The horizon is clearly 
visible and taking handheld pictures is relatively easy to do. Objects are clearly defined and no 
additional light is needed in most cases. The light cast during this phase can be anywhere from 
warm golden tones to cool pink tones. 
	 The colors of the sky change quickly. The sunset colors go away and an entire new set of 
colors splay out across the sky, cooler in temperature as time goes on. It’s important to adapt to 
the quickly changing conditions. As the next phase of twilight approaches, the gradation from the 
sunset point to the other end of the sky is going to become very smooth and pleasant, and the 
dynamic range of light in your images is going to decrease drastically.

Nautical Twilight— Nautical twilight occurs right after civil twilight in the evening, and right be-
fore civil twilight in the morning. This phase occurs when the center of the sun is between 6 and 
12 degrees below the horizon in the evening. This period also usually lasts around 30 minutes 
and the primary color cast across the atmosphere is usually a deep blue tone with still notice-
able orange and yellow hues left over from the fading sun. The horizon is still visible during this 
time but hand held shots are going to be somewhat difficult by now. The light has started to dis-
sipate quickly and silhouettes are going to be more prevalent in your shots. Details will be harder 
to make out during this time but there is still some remaining light on the horizon from the sun.	
	 During nautical twilight, the artificial lights in buildings and structures will really begin to take 
over the scene. Be sure to use a tripod during this time as hand held images will be extremely 
difficult. Pay attention to the way the remaining light and manmade light in your scene interacts 
with the subjects in your image. Use the directional light from the horizon to add hints of defini-
tion to objects and be ready to take multiple images as the light conditions will change rapidly.

Astronomical Twilight— The last phase of twilight is known as “astro” twilight. This period of 
twilight occurs when the center of the sun is between 12 and 18 degrees below the horizon 
and slowly degrades over a period of 30 minutes. A tripod is strongly suggested. During this 
phase of twilight, there is still some useable light to make for very interesting pictures. 
	 Cityscapes really comes to life during this time and the smallest light becomes a powerful tool 
of illumination. There is still a faint cast of dark blue across the horizon at first, and this slowly 
turns to black as night time begins. Away from the city, stars will be very visible and can be 
incorporated into some shots. Details will be somewhat difficult to make out without the help of 
some sort of artificial help. This phase of twilight is certainly the most difficult for creating  
images, but it can still be very rewarding. m

http://www.digital-photography-school.com/beyond-sunset-the-differen-phases-of-twilight#ixzz1Avmkcpg1
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and calendar events. (Of course, if your busi-
ness depends on those bookmarks, contacts, 
and events— this class of data moves up in the 
order of importance.) 
	 Reaction if lost: Non-stop cursing.

The Rest. This can be old e-mail, applications 
that you haven’t run since transitioning from 
OS 9 to OS X, your résumé from 1997… just 
about anything that you thought you might 
need some day but, in truth, were unlikely to 
ever look at again. 
	 Reaction if lost: “Huh.”

Know your backup options.
The days of casually jamming a floppy disk 
into a slot and dragging a couple of files on to 
that disk are gone. We now have multiple giga-
bytes of data to back up and slow, low-capacity 
solutions are no longer an option. These are 
the common backup choices at your disposal.
	 Writable optical media. Although Apple sees 
writable CD and DVD media as something of 
a dead-end, a lot of today’s Macs still bear a 
SuperDrive. Proponents of these discs once 
promised this media would survive for dozens 
of years. Regrettably, such claims haven’t 
been born out by the facts. Writeable CDs and 
DVDs can degrade over time, particularly when 
exposed to sunlight and moisture. And scratch 
it badly enough and your data is toast. It’s also 
a terribly slow means for backing up a lot of 
data. In a pinch, however, it’s a reasonable 
part of a sneakernet solution—one where you 
need to easily move data from one computer 
to another when you don’t have a network 
connecting the two.
	 While not natively supported by the Mac, 
writable Blu-ray discs are another option. 
Although subject to the same environmental 
threats as CD and DVD media, they hold more 
data—25GB on a single-layer disc and 50GB 
with dual-layer media. And Blu-ray burners 
have dropped in price. For around $250 you 
can purchase an external Blu-ray burner and 
copy of Roxio’s Toast Titanium 10 Pro, which 
allows your Mac to burn Blu-ray discs.
	 A Mac with second hard drive. Attaching 
a second hard drive to your Mac is the most 
common way to use Time Machine. Just plug 
in a FireWire or USB drive (or add a second  
internal drive if your Mac allows), switch on 
Time Machine, and let it do its stuff. Although 
Time Machine doesn’t allow you to choose 
specific items to back up, it does let you 
exclude items. So, for example, you could save 
some space by asking it to exclude the System 
folder at the root level of your startup drive. 
When you do this Time Machine offers you 
the option to additionally exclude all system 

How to make a 
solid Mac backup—
What should you back 
up, and how? Prioritize 
your data and keep 
it safe. You know you 
should back up your data. 

While some may fail to do so because they 
believe it’s a complicated process, and others 
because of their misplaced faith in the robust-
ness of hard drives, many Mac users simply 
don’t have a reasonable idea of what to back 
up and how to best go about it.
Edited from an article by  
Christopher Breen, Macworld.com— 

What should you backup?
Perhaps the best way to determine which 
data to back up is to consider just how terrible 
you’d feel after losing a particular class of data.
The Personal and Irreplaceable. When 
considering what to back up, this is the first 
broad filter you should employ—data and 
media that holds a special place in your heart 
and can’t be recreated. High on the list of the 
Personal and Irreplaceable are photos and 
home videos. Although it’s possible that you 
have the original images and videos on a tape 
or storage card, unless you’re the worst sort of 
hoarder, it’s likely you’ve erased or overwritten 
the original content. 
	 This is important to back up. Your teenager 
will never again be a toddler nor will your hair-
line naturally return to its 2002 whereabouts. 
And unless you have a photographic memory, 
you can’t recreate the letters you sent to your 
lady love in college (but really, you should 
have hand-written them). If such documented 
memories are important to you, backing up 
such media is the first thing you should do. 
	 Reaction if lost: Weeping and garment rending.

If Lost Will Get You Fired Or Thrown in 
Jail. Nearly as important as The Personal and 
Irreplaceable is that data which, if missing, 
threatens your job or freedom. Such files 
include work documents you’ve brought 
home that aren’t backed up at your place of 
business, documents you’ve spent months 
creating for tomorrow’s presentation, the Great 
American Screenplay due to the director in two 
day’s time, and your tax records. 
	 Reaction if lost: Trembling fear.

Would Be a Drag to Replace. A surprising 
amount of the stuff on your hard drive falls 
into this category. This includes music in your 
iTunes library (music you’ve ripped from CD 
or purchased online), iTunes videos, your 
browser bookmarks, address book contacts, 

applications and UNIX tools. This may be the 
easiest way to back up your data as it requires 
effort no greater than purchasing and plugging 
in a compatible hard drive.

Excluding system files from your backup can 
save you a lot of space.

The pros are obvious. Configuring a Time 
Machine backup with a second hard drive is 
dead simple to set up. The greatest effort it 
takes is purchasing the drive and plugging it 
in. The cons may not be quite so apparent 
to everyone. Should there be a cataclysmic 
event—a massive power surge, fire, flood, or 
earthquake—you could lose both your Mac’s 
hard drive and the secondary drive attached 
to it.
	 Mac with two external hard drives. 
The idea is similar as the single back up drive. 
The difference is that you rotate the drives and 
keep one of the drives off-site—in a bank’s 
safe deposit box, for example, or at a friend’s 
house. (If you have to store it on-site, get a 
waterproof fire-safe and place your second 
drive in it.) So, attach Drive A on Monday and 
let it back up your Mac throughout the week. 
Detach it on Sunday and swap in Drive B, 
allowing it to back up the Mac during the next 
week. If the worst happens, you lose, at most, 
a single week’s work. (Ed. note– heavy users.)

	 Time Capsule with network of Macs. 
If you have multiple Macs to back up, Apple 
has a solution in the form of its 1TB and 2TB 
Time Capsule wireless hard drive/routers 
(priced at $299 and $499 respectively). Like 
the single hard drive solution, it means your 
backup drive is on-site.
	 Home network server. If you live in a 
home with multiple Macs consider turning one 
of those Macs into a backup server. Detailed 
at length in the linked article, you can use 
a variety of software tools to automate the 
backup of multiple Macs over a network to a 
hard drive attached to the server.
	 RAID backup. RAID arrays—boxes that 
contain multiple hard drives packed with 
redundant data—were once the purview of 
corporations and well-heeled geeks. Thanks 
to Data Robotics’ Drobo and similar simplified 
RAID arrays, such boxes are now finding their 
way into home offices. “Redundant” is the key 
advantage here. If one of the array’s hard 
                                continued on page 5 >>

http://www.flickr.com/photos/iceman9294/page17/


Back-up, continued—
drives takes a dive, your data is still safe, as it’s 
backed up on another of the device’s drives. 
Again, it’s an on-site solution so it’s threatened 
by the same acts of nature that can destroy 
your Mac.
Online backup. Online backup provides a 
way to protect your data from those on-site 
disasters. Using an online backup solution 
such as MobileMe’s iDisk, Dropbox, or one of 
the many commercial online backup services 
you can upload your most precious data to the 
cloud. Should a real cloud flood your Mac and 
its local backup solutions, you can restore your 
data from the ether.
Make a backup plan!
How you backup depends a great deal on 
what you backup. You will, for example, wish 
to make multiple backups of Personal and 
Irreplaceable data and keep a rotating off-site 
backup. The rest can be backed up to the 
Time Machine drive attached to your Mac or, 
if you’re tired of being tethered to the past, 
ignored altogether. Now that you’ve deter-
mined which data is the most precious to you 
and understand the options for backing it up, 
let’s consider the steps you should take to 
back it up.
	 For your most prized data you must have a 
redundant backup plan. This starts with at least 
one local backup drive running Time Machine 
or another hunk of backup software—a tool 
such as Shirt Pocket Software’s $28 Super-
Duper or Bombich Software’s free Carbon 
Copy Cloner if you want a bootable backup. 
(Optionally you can back up to a home net-
work server.) A second backup drive that you 
keep off-site and rotate in on a regular basis is 
the second step.
	 For the crème de la crème of your data col-
lection—your iPhoto library and iMovie projects, 
for example—add an online storage service. 
This provides off-site backup without you hav-
ing to leave the house. If you can get by with 
just a couple of gigabytes of storage, Dropbox 
is an excellent and free choice. If you need 
up to 20GB of storage and have a MobileMe 
account, use your iDisk. And if you have a lot 
of data (and plenty of time to wait for it to 
upload) consider a more flexible online stor-
age solution such as the $54-a-year CrashPlan. 
CrashPlan not only lets you back up your data 
to its servers, but you can also back up data to 
a friend’s computer.
	 Such a redundant backup plan should 
leave you fairly well protected. But there are 
additional steps you can take.

Go even further.
For example, if you have a particularly hot 
project you’re working on at the moment, 
consider jamming a USB key drive into a spare 
slot on your Mac and copying that project’s 
files to it every hour or so. Should something 
awful happen and your regular backup system 
hasn’t had time to save your data, you lose 
only an hour’s work at most. (You can create 
an Automator workflow to automate this proc-
ess.)
	 iTunes provides an additional level of 
backup protection. You can burn a selected 
playlist to CD or DVD as data. To properly 
configure this option, select a playlist in iTunes’ 
Source list and choose File -> Burn Playlist to 
Disc. In the Burn Settings window that  
appears, enable the Data CD or DVD option 
and click the Burn button. After inserting a 
blank disc you’ll be told that the disc is only 
for data storage. If there’s more data than will 
fit on a single disc you’ll be asked if you’d like 
to split the playlist across multiple discs. Click 
Data Discs to confirm your choice to do so. 

Burn your music to disc as data.

	 Regrettably, iPhoto no longer offers an 
option to back up your iPhoto library to optical 
media. Rather, you can burn only images to 
the disc rather than the library itself and you 
can’t burn to multiple discs if the selected 
number of photos won’t fit on a single CD or 
DVD.
	 While you don’t need to back up your 
applications—because you can always install 
fresh copies—you should absolutely keep a 
record of your applications’ serial numbers and 
registration codes. That way, should you lose 
those applications, you needn’t go through the 
bother of contacting each software company 
in the hope that they’ll supply you with the 
numbers you need to run their programs.
	 Similarly, having a copy of your passwords 
and Internet configuration information will be a 
lifesaver if your hard drive dies. You can back 
up many Internet passwords by making a copy 
of your keychains. You’ll find them by going to 
youruserfolder/Library/Keychains. Agile Web 
Solutions’ $40 1Password is a terrific way to 

create and store passwords. Additionally, you 
can export 1Password archives for backup. 
These files should be part of a larger backup, 
but it doesn’t hurt to keep spare copies 
around. As for Internet configuration settings, 
one of the easiest ways to “back them up” is 
to take screen shots of the appropriate 
Network system preference and AirPort Utility 
screens and then print and back up those 
screen shots.
Safety in numbers.
For many of us it’s no exaggeration to say that 
we store much of our lives on our Macs— be 
it our financial history, online personalities, 
media, or memories. Losing that data is no 
longer a minor inconvenience. And because 
it isn’t, we must take serious steps to back it 
up. You now know what to back up and how 
to go about it. All that’s left is the seemingly 
most difficult step— actually taking the time to 
do it. m

Using  
Apple.com 
Support—
Apple has 
reorganized 
the Support 
section of  
Apple.com. 

Quite a lot of effort has been put into 
creating a one-stop place for all the 
support you may need for your Mac, 
software, iPod, or iDevice. 

Here’s a rundown of what you can find:

•	 Troubleshooting tips

•	 Product manuals and user guides (Re-	
	 member when these came in the box?)

•	 Technical Specs

•	 Genius Bar reservations

•	 Apple Care support

•	 Training tips and videos

•	 Express Lane, which is a way to give infor	
	 mation about your product and your prob-	
	 lem to Apple Support before you call them 	
	 which saves time when you are actually on 	
	 the phone.

Obviously, Apple.com is a great sales and 
information tool for Apple, but if you need  
assistance after the sale, their new support 
page is top-notch. m
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Installing software  
on a Mac with a dead  
DVD drive—
by Christopher Breen, Macworld.com

A reader passed along an old Mac mini to 
her son. When setting it up she inserted 
a CD to install some software and discov-
ered that the media drive is broken—the 
CD just spins and spins and never mounts. 
She has a MacBook with a working media 
drive. Is there some way she can connect 
the Mac mini to the MacBook to install 
software?

Yes. You can use the media drive on your 
MacBook to install software to the Mac mini. 
This can be accomplished via FireWire Target 
Disk Mode or through disc sharing. They work 
this way:
FireWire Target Disk Mode method: 
String a FireWire cable between the two Macs. 
Restart the MacBook while holding down the 
T key. Boot the Mac mini and you should find 
that the MacBook’s hard drive appears on the 
mini’s Desktop. Now insert an install CD or 
DVD in the MacBook’s media drive. It too will 
appear on the mini’s Desktop as a removable 
volume. Open that volume and double-click 
on the installer. The installer will go about its 
business.
Disc sharing method: Disc sharing is a 
scheme designed by Apple that allows a 
MacBook Air to use a CD or DVD inserted in 
another Mac on the same local network. With 
a slight bit of trickery you can make it work 
with your MacBook and Mac mini too.
	 To do so, first launch System Preferences 
on the MacBook, select Sharing, and enable 
DVD or CD Sharing. (If you want to be asked 
before sharing a disc, make sure the Ask Me 
Before Allowing Others To Use My DVD Drive 
option is enabled.) Now here’s the trickery. 
Launch Terminal on the Mac mini and enter 
these two commands, pressing “Return” after 
each:

defaults write com.apple.NetworkBrowser 
EnableODiskBrowsing -bool true

defaults write com.apple.NetworkBrowser 
ODSSupported -bool true

Restart the Mac mini.
	 With the two Macs on the same network, 
insert the install CD or DVD into the Mac-
Book’s media drive. A Remote Disc entry will 
appear in a Finder window’s sidebar on the 
Mac mini. Select it and you’ll see the name of 

the MacBook. Double-click on the MacBook 
entry and you’ll find the disc that’s inserted in 
the MacBook’s drive. Double-click it to install. 
Because it’s operating over a network the 
installation will take longer than it would if you 
were using the disc in the mini’s media drive 
(if it worked, of course).

An install DVD seen through disc sharing

Disk image method: Finally, you could 
create a disk image on the MacBook, copy it 
to the Mac mini, and then run the disk image 
as if it was the original disc. To do that, insert 
the disc in the MacBook’s media drive and 
launch Disk Utility (found in /Applications/
Utilities). In Disk Utility’s Sources list select the 
disc. Choose File -> New -> Disk Image from 
nameofdisk. In the sheet that appears choose 
DVD/CD Master from the Image Format pop-
up menu, None from the Encryption pop-up 
menu, and click Save.
Disk Utility will take some time creating the 
disk image. Once the image has been creat-
ed, copy it to the Mac mini over the network, 
double-click on it to mount it, and run it as if it 
was the original disc. m

Mac Switcher Guides— 
By: ChrisB– Basics4Mac
If you are a Windows 
user that is switching to a 
Mac (Welcome!) or know 

someone who is, you might be interested in 
a series of articles from Macworld to get you 
going on the switching process.
	 This series is about a year old, but the in-
formation these guides contain is still current.
Go to the main article to find links on moving 
your files and hardware to the Mac, getting 
used to OS X, running Windows on a Mac, 
and understanding Mac security.

Switchers guide: moving from Windows to 
the Mac— CLICK HERE

PS Elements 9, Visual 
Quickstart Guide— an 
InfoManager review— 
By: Jeff Carlson (edited)
A good reference book 
which can be read from 
the first chapter for 

the novice, or just used a refer-
ence guide for the medium to 
advanced ‘PS Elements 9 user. 
There are 14 chapters and seven 
pages of Keyboard shortcuts at 
the end of the book.
     There’s some great content 
in here, like resolution and image 
size which few people under-
stand, and the under-used Paint 
Bucket tool. Like correcting for 
camera distortion (when the 
buildings in your photos appear 
to bend inward). With Photoshop 
Elements 9 you can correct that 

easily, but few people understand that you 
can, or even care to. Some people feel that’s 
the way cameras work and just accept that. 
Some of us just can’t think that way.
	 This is a book that I can recommend for 
those who buy Photoshop Elements 9 and 
have that deer in the headlights glaze in their 
eyes when they first open up the program. 
This book should help you get your battery 
jump-started. m

Easily Find Specialty Symbols— 
By Kali Hilke, SmallDog.com Kibbles & Bytes

I can now find ® and ™ in my sleep. However, 
if you find yourself hunting for those or any of 
the hundreds of other specialty symbols, look 
no further than the Character Palette (actually 
now known as just “Characters” in  OS 10.5 
and 10.6).
There, you will see a full lists of characters, 
from punctuation to mathematical symbols 
to braille patterns. To get to it, just do the 
following:
•	 Select Edit > “Special Characters…” from 
whatever application you’re in (e.g. TextEdit, 
Safari or Mail) or choose the Character Viewer 
icon in the upper righthand part of the menu 
(if you’ve chosen to display the icon there. 
More on that in a sec.)
Keyboard shortcut: Shift-Command-T
•	 Choose “View: All Characters” from the 
drop down menu in the window (if it doesn’t 
automatically display all by default)
Add your most used to the Favorites section, 
and you’ll be good to go!

http://www.macworld.com/article/143519/article.html


choices are Good Quality (128 kbps), High 
Quality (160 kbps), and Higher Quality (192 
kbps). For each encoder you also have a 
Custom option. Select it and a new window 
opens where you can choose from among 
a variety of bit rates. Again, the higher the bit 
rate, the better the audio quality and the big-
ger the file.
	 You can also view iTunes’ Import Settings 
by selecting the CD in iTunes’ Source list and 
clicking the Import Settings button at the 
bottom-right of the iTunes window. Addition-
ally, with Doug Adams’ free Rip A Few My Way 
AppleScript installed, you can invoke the script 
from iTunes’ AppleScript menu and choose 
the encoder you’d like to use for selected CD 
tracks.

Step Two: Insert and select a CD—
Insert a music CD into your Mac’s media 
drive. By default, iTunes will launch, the CD’s 
name will appear in iTunes’ Source list and be 
selected, and the CD’s track names will appear 
in iTunes’ main window.
	 If the CD’s track names don’t appear it 
either means that your computer isn’t able to 

communicate via the Internet (which is how 
iTunes obtains album, artist, and track names) 
or the CD is one that’s not recognized by 
iTunes (a “mix tape” CD a friend has created, 
for example). For those CDs that don’t have 
track names automatically added, you can click 
on individual titles & add names manually.
	 Also, by default, a window appears that 
reads:
Would you like to import the CD “name of 
CD” into your iTunes library?
	 Click Yes to import all the individual tracks 
on the CD or No if you’d prefer to not import 
the tracks at all (or do it at another time).
	 If you click No and later wish to import the 
tracks from the CD, select the CD in iTunes’ 
Source list and at the bottom-right of the 
iTunes window click on the Import CD entry. 
iTunes will begin ripping the CD and adding 
the tracks to the iTunes library.  

February 2011  |  MUGSHOT Newsletter  |  7

	 If you’d like iTunes to rip just selected 
tracks, uncheck the tracks that you don’t want 
to rip.

Step Three: Optionally join tracks—
There may be times when you want to  
combine multiple tracks into a single track.  
For example, if you have an audiobook CD 
that includes lots of short files that you’d 
like to play as a single larger file, or a series 
of live songs that segue smoothly and you’d 
like to keep together. To combine tracks,  

simply select the 
files you want to 
join and choose 
Join from iTunes’ 
Advanced menu. 
iTunes will place a 
bracket next to the 
tracks that will be 
joined when you
click Import CD. m

Google Privacy:  
A Look At Cookies—
with Maile Ohye,  
Google Support Engineer

•	 Transparency– Google provides detailed 
information about our advertising policies and 
practices.
•	 Choice– Google offers innovative ways to 
view, manage and opt out of ad cookies.
•	 No personally identifying information 
We don’t collect or serve ads based on 
personally identifying information without your 
permission. 
	 Editor’s note: To learn what you can 
do to limit your exposure to unwanted ad 
messages when using Google, go here to 
view a series of videos with Maile.  

Easily copy music CDs to iTunes—
by Christopher Breen, Macworld.com

There’s a very good chance that you already 
have a load of music just waiting to make its 
way to your computer and iOS device— your 
CD library. Here are the steps for turning your 
discs into digital files.

Step One: Check your iTunes settings—

By default, iTunes will import (or rip) CD tracks 
using the AAC encoder at 256 kbps. This is a 
“lossy” compression format (meaning iTunes 
makes your tracks consume less space by re-
moving audio data that you shouldn’t be able
to hear). However, it’s also a lossy compres-
sion format set at a high bit rate, which means 
it should be extremely difficult (if not impos-
sible) to detect any difference between the 
original and ripped versions.  
	 If you’d like to change the encoding set-
tings—either to save more space by choosing 
a smaller bit rate such as 128 kbps or to get 
a higher quality file by choosing a lossless en-
coder such as Apple Lossless or AIFF—choose 
Preferences from the iTunes menu and click 
the General tab.
	 To change the import settings, click on the 
appropriately named Import Settings button. 
In the resulting Import Settings window you 
can choose AAC Encoder, AIFF Encoder, Apple 
Lossless Encoder, MP3 Encoder, or WAV
Encoder from the Import Using pop-up menu. 
AAC and MP3 are both lossy encoders. The 
Apple Lossless encoder cuts file size approxi-
mately in half without losing audio quality. The 
AIFF and WAV encoders maintain audio files at
their original size and resolution. (Using these 
encoders a 4-minute track is approximately 
40MB.)
	 When you select either AAC Encoder or 
MP3 Encoder in the Import Using pop-up 
menu you can choose a different
bit rate in the Setting pop-up menu below. 
When you choose AAC Encoder your preset 
choices are High Quality (128 kbps), iTunes 
Plus (256 kbps), or Spoken Podcast (64 
kbps). Choose MP3 Encoder and your preset 

http://www.google.com/privacy/ads/ 
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OMUG Meeting Information—

The Ocala Mac User Group meets on the  
2nd Tuesday of the month at the  
following location to the SE of Ocala:

St. George Anglican Cathedral—  
Parish Hall
5646 SE 28th St., Ocala, FL 34471 
(352) 624-0112 
See www.ocalamug.org for a map

OMUG Board of Directors—

President– N.C. Sizemore
ncsizemore@gmail.com • 291-8778 
Vice President– Dr. Roberto Putzeys
rputzeys@cox.net • 873-3218 
Secretary– Nancy Kirby
nkirby1944@embarqmail.com
Treasurer– Judy Rankin 
judyrankin@mac.com • 821-2322 
Director– Philip Davis
p.davis@ocalamug.org • 369-8432
Director– Burt Stephens
burtstephens@gmail.com • 873-6177  
Director– Al Sypher
aes@imageocala.com • 237-9501
Director– position open
 
Past President– Tim Rankin
rank.tim@gmail.com • 821-2322

Mac Users Helping Mac Users—

OMUG volunteers will try to help with your 
computer and software problems. Please add 
your name to this list if you are willing to 
share your expertise with other OMUG 
members.

General Mac Problems– Tim Rankin
rank.tim@gmail.com • 821-2201
Print Shop or Print Explosion– 
Judy Rankin 
judyrankin@mac.com • 821-2322
General Mac Problems— Web Design 
Philip Davis (email ONLY) 
p.davis@ocalamug.org 

OMUG Assignments—

Assist. Secretaries– Sally Smyth and
Shelley Sizemore
Fifty-Fifty Raffle– Earl Satterfield 
Membership– Nancy Kirby 
MUGSHOT Newsletter– Al Sypher
Program Coordinator– Burt Stephens
Refreshments– Della Marteny and 
Ed Jaworowski
Sunshine Lady– Virginia Baldwin 
vbaldwin@atlantic.net • 629-6308 
Webmaster and  
Apple Ambassador– Philip Davis Disclaimer—  

The Apple logo is the property of Apple, Inc. The Windows logo is the property of Microsoft, Inc. All tradenames, trademarks, and registered  
trademarks used herein are the property of their respective owners or companies. The information presented in this newsletter is for the  
personal enlightenment of OMUG members and friends, does not constitute an endorsement, and is not to be used for commercial purposes.

“How Does The Apple iPad Compare With the Mac Laptop?”  - A OMUG Presentation, February 8, 2011
Presented by Bobby Adams, OMUG Member

Bobby will compare the iPad with the Mac laptop.  He will identify features of both devices, e.g., type, size, weight, 
power required, battery life.  Some of the characteristics are directly comparable; others are not, e.g., their operating 
systems, touch-based capability, multiple-touch and gesture characteristics. The iPad represents another step in  
evolution of computers but is it a viable replacement for your laptop?
	 References used in Bobby’s presentation will include: the “iPad Handbook Summer 2010” from Mac Life, an article 
in Popular Electronics - Oct 2010, “Taking Your iPad to the Max,” “iPad Made Simple,”  “iPad: the Missing Manual,”   
“Apple iPad website,” - www.apple.com/ipad, and numerous blogs.

OCALA MACINTOSH USER GROUP — MEETING MINUTES: January 11th, 2011

NC called the meeting to order at 7 PM. There were 4 guests: Joe Atiles, Michael Berryhill, Fred 
Johnson and John Neal. The Christmas Party was a big success and the food provided by My Sons 
Catering was delicious. NC announced the death of longtime Mac User and OMUG supporter Tom 
Brannan. A memorial contribution was made to Camp Kiwanis in his honor.

Phil made several announcements about iPhone coming to Verizon stores in February and the new 
AppStore available to Mac Users with Snow Leopard which will enable you to download Applications 
(some free!) through an icon in the dock. Automatic download to your Applications folder, can be  
installed on any computer you own and keeps a list of your purchases, so if you buy a new  
computer you can download previously purchased software at no additional cost.

MacWorkshops:  The workshops are drawing big crowds and covering lots of information. They 
are held at the church on the third Saturday of the month and Phil has recently released a proposed 
agenda for the rest of the year. See the OMUG website for more information.

S.I.G.S.: The first S.I.G., Mac Video Group was held on Saturday, January 15th at J.P. Leemans’ 
home. There were 5 people in attendance and they all have homework!

Secretary’s Report: The November meeting minutes were accepted with no changes.

Treasurer’s Report: Judy Rankin reported that as of January 11, there was $388.17 in the treasury.

Program Topic: Healthy Ocala—  Presenter, Bob Halloran

Program Highlights: Bob, a long time Mac user is a Nuclear Engineer and Physicist who teaches at 
Central Florida College as well as retired Chairman and CEO at the National Background Data Group. 
He currently works with the Public Policy Institute of Marion County working to discover issues of 
importance to citizens of Marion County. His presentation concerned the implementation of Healthy 
Ocala, which will eventually be a means for Physicians, Hospitals and patients to access the patient’s 
electronic health records from all sources 24/7. Just getting underway, currently there are three  
participating Physicians in Marion County.  •  See Healthy Ocala website for more information. 

Mac Tips: Dr. Roberto Putzeys strongly recommended against using MacTune-up which completely 
shut down his computer!

Q & A: Questions included:  request for info on best Laser printer, what to do if your screen goes 
black (jiggle the mouse, check your preferences for time-out setting), transferring movies from 
iPhone, using Magic Mouse with 20” iMac.

Phil also provided some tips and warnings about MalWare, SpyWare and Viruses which are now 
posted on the OMUG website. Lots of information there, so be sure to check it out often!

Members enjoyed refreshments, planned and served by Ed Jaworoski and Della Marteny.

50/50 Drawing Winners: 

Elaine Smith – $40.00 (two wins); Carolyn Docteur – Red Lobster Gift Certificate ($25); Marilyn 
Kennedy and Luis Carrascoso – 2g Flash drives; Phil Davis – Outback Gift Certificate ($25)

Attendance: Twenty-eight members. Meeting adjourned at 9:00 PM. 

Respectfully submitted by:  Nancy Kirby, OMUG Secretary

COMING UP...

http://www.ocalamug.org/mappage2.html
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